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1. Kernel for Lotus Notes to Novell GroupWise 

Welcome to the user manual of Kernel for Lotus Notes to Novell GroupWise software, an ideal and 
convenient software to migrate data in Lotus Notes NSF file to Novell GroupWise mailbox. The user 
manual of Kernel for Lotus Notes to Novell GroupWise comprises step by step guidelines on using the 
software and converting Lotus Notes to Novell GroupWise.  

 

1.1  Using this Manual 

This user manual has been devised to guide the users to perform migration using Kernel for Lotus Notes 
to Novell GroupWise. It is suggested that the first time users must read this user manual completely and 
carefully before proceeding to use the software. The Table of Contents of this user manual enlists all the 
sections that are contained in this user manual in chronological order. The Table of Contents section can 
be used even by the experienced users for information related to tasks that you perform using Kernel for 
Lotus Notes to Novell GroupWise. Use the Table of Contents to navigate through different sections of this 
user manual. The user manual comprises the following sections: 

 Introduction 

 Getting Started 

 Software Interface 

 Lotus Notes to Novell GroupWise Migration 

 Full Version 

 Support 

 Legal Notice 

Certain abbreviations have been used throughout this manual. For clear understanding of the contents of 
this user manual, please go through the list of abbreviations, mentioned below, before reading the manual.  

1.1.1 List of Abbreviations  

NSF: Notes Storage Facility (Lotus Notes Database) 

RAM: Random Access Memory 

MB: Mega-Byte 

GB: Giga-Byte 
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1.2  Introducing Kernel for Lotus Notes to Novell GroupWise 

Kernel for Lotus Notes to Novell GroupWise is an ideal Lotus Notes to Novell GroupWise migration tool 
that helps you migrate Lotus Notes NSF file data to Novell GroupWise easily. This software lets you  
convert all the email data such as emails, calendars, address books, appointments, tasks, sent items, 
drafts, journals, calendars, and every other item existing in NSF files to GroupWise mailbox.  

This software converts orphan NSF file(s) to GroupWise mailboxes along with converting multiple NSF 
file(s) from Domino Server to GroupWise mailboxes. The data so transferred from NSF to GroupWise is 
not modified at all and therefore the data integrity of the file is maintained. The software uses NSF file(s) 
as read-only copy, collects information from the NSF file and migrates data from NSF to GroupWise 
mailbox.  

1.3 Salient Features 

Salient features of Kernel for Lotus Notes to Novell GroupWise include: 

 Converts unlimited NSF files to GroupWise mailbox 

 Fetch NSF files from Domino Server and convert them to GroupWise 

 Supports UNICODE character conversion 

 Saving options: txt format and rtf format (low and best quality) 

 Filter email items  

 Displays preview 

 Converts emails, attachments, contacts, calendars, appointments, tasks, and every other folder in 
NSF file 

 Allows you to migrate view folder items 

 Self-descriptive graphical user interface 

 Supports every version 
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2. Getting Started 

Now that you have understood the features and potential of Kernel for Lotus Notes to Novell GroupWise, 
you are ready to get hands on experience of the software. In order to start the Lotus Notes to Novell 
GroupWise migration, you first need to download and install the software. It is strongly recommended that 
before you install Kernel for Lotus Notes to Novell GroupWise, you should go through the installation pre-
requisites for the software to ensure that your computer is appropriately configured to run the software.  

 

2.1 Installation Pre-requisites 

The various pre-requisites for installing and running Kernel for Lotus Notes to Novell GroupWise can be 
broadly classified into two major categories – Hardware requirements and Software requirements. 

2.1.1 Hardware Requirements: 

The hardware requirements for installing the software are as follows: 

 Pentium class processor 

 Minimum 64MB RAM (128 MB recommended) 

 10MB for Software installation 

 Disk Space - Enough space to store the repaired files 

2.1.2 Software Requirements: 

The software requirements for installing the software can further be grouped into two categories – 
Operating system requirements, Lotus Notes, Domino Server and GroupWise version requirements. The 
requirements are as follows: 

2.1.2.1 Operating System Requirements 

Supported operating systems: 

 Windows 7 

 Windows Vista 

 Windows XP 

 Windows 2003 

 Windows 2000 



©  L e p i d e  S o f t w a r e  P r i v a t e  L i m i t e d         

2.1.2.2 Email client Requirements 

Supported Lotus Notes versions: 

 Lotus Notes 6.0  

 Lotus Notes 6.5  

 Lotus Notes 7.0  

 Lotus Notes 8.0  

Supported Domino Server Versions 

 Domino Server 6.0  

 Domino Server 6.5  

 Domino Server 7.0  

 Domino Server 8.0 

Supported Novell GroupWise Version 

 GroupWise 5.5  

 GroupWise 6  

 GroupWise 6.5  

 GroupWise 7  

 GroupWise 8  

 

 Before installing Kernel for Lotus Notes to Novell GroupWise make sure that Lotus 
Notes and GroupWise are installed on your computer. Also, if you wish to migrate 
data directly from Domino Server then you need to have Domino Server installed on 
your computer or connected to a computer having Domino Server installed on it. 

 

2.2 Downloading the software for the First Time 

After checking your computer with the prescribed system requirements for Kernel for Lotus Notes to Novell 
GroupWise, you can download and install the software on your computer. You can buy the full version of 
the software from any one of our authorized resellers– Element5, Asknet and 2CO. 
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If you want to try using Kernel for Lotus Notes to Novell GroupWise before buying it, you can download the 
evaluation version from the following link: 

http://www.nucleustechnologies.com/download-notestogroupwise.html  

 You can use the evaluation version of Kernel for Lotus Notes to Novell GroupWise to 
perform migration; however, evaluation version generates allows the user to migrate 
only 10 email items per folder of the NSF file. 

2.3 Install Kernel for Lotus Notes to Novell GroupWise  

After downloading the installer file for Kernel for Lotus Notes to Novell GroupWise, execute the following 
steps: 

1. Double-click the Kernel for Lotus Notes to Novell GroupWise installer file.  

2. Follow the on-screen instructions. When the installation process completes “Setup Installation 
Complete” message appears on the software installation screen.  

3. Click the Finish button to launch the software.  

Following these steps, Kernel for Lotus Notes to Novell GroupWise will be installed on your computer 
successfully.  

 

2.4 Start Kernel for Lotus Notes to Novell GroupWise 

To start Kernel for Lotus Notes to Novell GroupWise: 

Click the Start  All Programs  Kernel for Lotus Notes to Novell GroupWise  Kernel for Lotus 
Notes to Novell GroupWise 

Alternatively, you can launch Kernel for Lotus Notes to Novell GroupWise by double-clicking the shortcut 
icon available on the desktop and Quick Launch icon. 

 

2.5 Uninstall Kernel for Lotus Notes to Novell GroupWise 

You can uninstall Kernel for Lotus Notes to Novell GroupWise software from your computer system by 
using any of the following two methods: 

 Uninstall from Windows Start Menu  

 Uninstall from Control Panel  

 Before proceeding to uninstall Kernel for Lotus Notes to Novell GroupWise, you 
must ensure that the software is not running.  

http://www.nucleustechnologies.com/download-notestogroupwise.html
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2.5.1 Uninstall from Windows Start Menu: 

Perform the following steps to uninstall Kernel for Lotus Notes to Novell GroupWise from Windows Start 
menu:   

1. Click Start > All Programs > Kernel for Lotus Notes to Novell GroupWise > Uninstall Kernel 
for Lotus Notes to Novell GroupWise. A warning message before un-installing the software will 
be displayed on the screen.  

2. Click the Yes button to uninstall the software.  

3. Click the OK button.  

 

Kernel for Lotus Notes to Novell GroupWise is successfully uninstalled from your computer system.  

 

2.5.2 Uninstall from Control Panel: 

Alternatively you can also uninstall Kernel for Lotus Notes to Novell GroupWise from Control Panel by 
executing the following steps: 

1. Click Start > Control Panel. The Control Panel window appears.  

2. Double-click the Add or Remove Programs icon. A list of the programs installed on your computer 
appears.  

3. Select Kernel for Lotus Notes to Novell GroupWise and click the Remove button.  A warning 
message before un-installing the software will be displayed on the screen.  

4. Click the Yes button to un-install the software.  

5. Click the OK button.      

Kernel for Lotus Notes to Novell GroupWise is successfully uninstalled from your computer system. 
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3. Software Interface 

Now that Kernel for Lotus Notes to Novell GroupWise has been installed on your computer, you can start 
using the software after getting acquainted with the software interface. 

3.1 Menu-bar 

The menu-bar of Kernel for Lotus Notes to Novell GroupWise comprises three main menus – File, Tool, 
and Help. 

3.1.1 File Menu 

File menu of Kernel for Lotus Notes to Novell GroupWise is shown in following figure: 

 

Figure 3.1: File Menu 

Menu items in the File menu: 

Field Name Field Description 

Exit Select to close the software 

The File menu comprises a single option i.e. Exit, which can be used to close the software. 

3.1.2 Tools Menu 

The Tools menu comprises single menu item. 

 

Figure 3.2: Tools Menu 

Menu Items in the Tools menu: 

Field Name Field Description 

Advance Settings Allows you to configure some additional 
software settings. 

The Tools menu comprises Advance Settings option, which enables you to configure some additional 

software settings. When you select the Advance Settings option, the Advance Settings dialog box 

appears: 
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Figure 3.3: Advance Settings 

Advance Settings option allows you to configure settings while migrating View Folders to GroupWise along 
with all the other folders; lets you modify the default name of email folders in GroupWise. Also, you can 
add new folder in the list of Default Lotus Notes Folders. These folders can be removed anytime from the 
list but make sure that default folder cannot be removed. Here is the list of options available in the 
Advance Settings dialog: 

Option    Description 

Show “View Folders” Selecting this option will configure the software to 
migrate Lotus Notes View Folders to GroupWise 
mailbox along with other folders in NSF file. 

Edit Name of Lotus Notes folders to be 
migrated to GroupWise Mailbox 

Selecting this option enables you to modify the 
name of Lotus Notes folder(s) that you are migrating 
to GroupWise mailbox. To modify the folder name, 
click beside the folder name in GroupWise Folders 
section, modify the name, and click the Apply 
button. 

Apart from modifying the folder name, you can also 
add / remove new folder using following buttons: 

 Add User Folder: Click this button to 
add a new folder in Lotus Notes and 
GroupWise Mailbox.  
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 Remove Folder: Click this button to 
remove folder from the Lotus Notes and 
GroupWise Folders list.  

 Use Default: Brings the folders name to 
default names.  

 

3.1.3 Help Menu 

Help menu of Kernel for Lotus Notes to Novell GroupWise is shown in following figure: 

 

 

Figure 3.4: Help Menu 

Menu items in the Help menu: 

Field Name Field Description 

Help Select to view help information pertaining to performing 
various tasks using Kernel for Lotus Notes to Novell 
GroupWise 

Software Home page... Select to visit software homepage on our website 

About Kernel for Lotus 
Notes to Novell GroupWise 

Select to view version-related and support information of 
Kernel for Lotus Notes to Novell GroupWise 

3.2 Tool-bar 

The tool-bar in Kernel for Lotus Notes to Novell GroupWise is displayed below the menu-bar. The tool-bar 
provides a convenient and user-friendly method to perform certain actions that can also be performed by 
using the menu-bar. Read the information in the table below to find out about the tool-bar buttons: 

Buttons Button Description 
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Enables you to list individual NSF file(s) for 
migration to GroupWise mailbox. 

 

Enables you to fetch NSF files from 
Domino Server and migrate to GroupWise 
mailbox. 

 

Allows you to migrate the selected NSF 
file(s) to GroupWise mailbox 

 

Opens the software user manual. 

 

Opens the software website to let you 
purchase the Kernel for Lotus Notes to 
Novell GroupWise. 

 

3.3 Buttons Used 

There are various buttons used in the software to make the task of NSF to GroupWise migration easy and 

speedy. Following table lists the buttons used in the software: 

Buttons Description 

 

Enables you to list individual NSF file(s) for migration to 
GroupWise mailbox. 

 

Enables you to fetch NSF files from Domino Server and 
migrate to GroupWise mailbox. 

 

Removes the selected NSF file from the list of NSF files 
that you want to convert into GroupWise mailbox. 

 

Removes all NSF file from the list of NSF files that you 
want to convert into GroupWise mailbox. 
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Collapses the list of NSF files that you want to convert into 
GroupWise mailbox. 

 
Expands the collapsed list to provide you detailed view of 
listed NSF files. 

 
Displays preview of selected NSF file amid all NSF files 
listed for migration. 

 
Allows you to migrate the selected NSF file(s) to 
GroupWise mailbox. 

 
Takes you a step ahead in the migration process. 

 
Takes you a step back in the migration process 

 
Enables you to specify a location to save GroupWise 
mailbox, which will be created from NSF file during 
migration process 

 
Closes the currently opened window or dialog box. 

 
Stops the ongoing process. 
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4. Lotus Notes to Novell GroupWise Migration 

As discussed above, Kernel for Lotus Notes to Novell GroupWise is devised especially to migrate Lotus 
Notes NSF file to Novell GroupWise. Using this software, you can migrate data from NSF file saved on 
local computer as well as NSF files saved on Domino Server. Here is how you can perform Lotus Notes to 
Novell GroupWise migration: 

4.1 Convert NSF File on local computer to GroupWise Mailbox 

Here are the steps to convert NSF file saved on Local computer to GroupWise Mailbox: 

1. Select Start > All Programs > Kernel for Lotus Notes to Novell GroupWise > Kernel for Lotus 
Notes to Novell GroupWise to launch the software. The software main window appears: 

 

Figure 4.1: Main Screen of the software 
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2. Click the Add File(s) button in the Tool bar to add NSF file in the software for migration. The 
“Select Lotus Notes database files” dialog box appears: 

 

Figure 4.2: Select Lotus Notes database files dialog 

3. Click the Add From Local button to add NSF file(s) available on your local computer. The “Open” 
dialog box appears: 
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Figure 4.3: Open dialog to select the NSF file for migration 

4. Select the file(s) and click the Open button. Selected file(s) will be listed in the “Select Lotus Notes 
database files” dialog box:  

 

Figure 4.4: NSF files enlisted for migration 
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5. Select the Allow user to select or add GroupWise Mailbox name check box if you want to specify 
a new name to the GroupWise mailbox. For example, if the current name of the NSF file is 
Database1 and you want to keep this name as GroupWise Database 1 then select the Allow user to 
select or add GroupWise Mailbox name check box and type the new name. 

 If you have selected multiple NSF files, then specifying a new name will merge the 
email folders in the NSF files and a single GroupWise mailbox will be created at the 
specified location. If you do not want to merge folders of NSF files then you should 
not select the Allow user to select or add GroupWise Mailbox name check box. 

6. Click the OK button. Selected NSF file(s) will be listed in the software for migration: 

 

Figure 4.5: NSF file(s) enlisted in the software for Migration 

7. Select the file if you want to preview it before migrating into GroupWise mailbox 

8. After selecting the file, click the Preview button. The software displays preview of the selected NSF 

file: 
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Figure 4.6: Software displaying the folder structure of NSF file 

9. Select a folder to preview its items. The software starts listing items of the selected folder: 

 

Figure 4.7: Software enumerating folders in NSF file 
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10. After previewing, click the Export button. The “Options for Migration” dialog box appears: 

 

Figure 4.8: Options for Migration dialog to select location for saving converted data 

11. Click the Browse button to specify a location to save the GroupWise mailbox. The “Browse for 
Folder” dialog box appears: 
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Figure 4.9: Browse Folder dialog to select saving location 

12. Select a location and click the OK button. The selected location will be displayed in the “Options for 
Migration” dialog box: 
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Figure 4.10: Mailbox Destination selected 

13. Click the Next button. The “Items to Migrate” page appears enabling you to select email object that 
you want to migrate: 

 

Figure 4.11: Items to Migrate to GroupWise Mailbox 

14. Select objects that you want to migrate and deselect that you do not want to migrate into 
GroupWise mailbox.  

15. Click the Next button. The “Date Range to Migrate” page appears allowing you to specify a date 
range based on which the software will migrate email items to GroupWise: 
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Figure 4.12: Selecting the Date range for migration 

On this page, you are provided with two options – Predefined and User defined. Selecting the 
Predefined option will enable you to specify a date range from the available list of date range while 
the User defined option allows you to specify your own date range.  

16. Specify the date range and click the Next button. The “Quality and Speed of Migration” page 
appears allowing you to select a saving option: 
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Figure 4.13: Defining Quality and Speed of Migration 

Based on the saving option that you will select, the speed of migration will vary. Mentioned below 
are the saving options that you can select for migrating NSF to GroupWise:  

 Save emails in text format - fastest speed: Saves data in textual format. It is the fastest 
mode of migration in Kernel for Lotus Notes to Novell GroupWise.  

 Save emails in rtf format - Low Quality - Medium Speed: Saves data in RTF format. 
Selecting this mode will slows down the speed of migration but the quality (formatting, 
properties, structure, etc.) of the emails, contacts, etc. will be better than the emails migrated 
using Save emails in text format – fastest speed option.  

 Save emails in rtf format - best Quality - Lowest Speed: Also saves data in RTF format but 
produces the best quality i.e. the data will be migrated in the same format as it was in NSF 
file. However, this option may take some large time in migrating NSF to GroupWise.  

17. Select an option and click the Next button. The software starts converting NSF to GroupWise:  
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Figure 4.14: Migration in process 

When the Migration process gets completed, the Migration Complete message appears. Click the OK 
button to close the dialog box displaying the Migration complete message. Now, click the Next button if 
you want to migrate more files to GroupWise else click the Exit button to close the software. 

 

4.2 Convert NSF File on Domino Server to GroupWise Mailbox 

Kernel for Lotus Notes to Novell GroupWise is designed to conduct email migration with utmost ease and 
accuracy. Using this tool, an administrator can fetch the NSF files directly from Domino Server and convert 
the same to GroupWise mailbox. The only condition while migrating NSF files from Domino Server is that 
the Domino Server must be in running state. This means that administrator can effectively migrate emails, 
contacts, tasks, appointments etc from Domino Server to GroupWise. Here are the steps that should be 
executed to migrate NSF files from Domino Server to GroupWise:  
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1. Launch the software.  

2. Click the Add Domino File(s) button. The “Domino Server File Selection” dialog box appears: 

 

Figure 4.15: Domino Server File Selection 

 

By default, the software enables you to convert NSF files on local computer into GroupWise mailbox; 
therefore, you see [LOCALCOMPUTER] mentioned in text box beside the Add Domino Server button. If 
you want to convert NSF files available on local computer into GroupWise mailbox then click the Add 
Domino Server button. As you click the Add Domino Server button, [LOCALCOMPUTER] will be added 
in the Domino Server Name(s) list box. Now, navigate to Step 6 for further processing. However, if you 
want to fetch NSF files from remote server, navigate to Step 3 for further processing.  
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3. Click the Search Domino Server button to locate the Domino Server. The software displays a 
message that the process of finding server may take some time: 

 

Figure 4.16: Enumerating Server Information 

 If you know the name of the Domino Server then type its name in the text box beside 
the Add Domino Server button and then click the Add Domino Server button. The 
server will be added in the Domino Server Name(s) section.  

4. Click the Yes button. The software starts locating Domino Server. As soon as the server is found, 
the software prompts you to specify its password: 
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Figure 4.17: Software prompting for Lotus Notes authentication 

5. Type the password and click the OK button. The server will be listed in the Domino Server Name(s) 
section: 
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Figure 4.18: Server enlisted for extracting NSF files 

6. Select the server name or [LOCALCOMPUTER] depending on the steps executed above. All NSF 
files available at the server / local computer get listed in the “Select the required NDF files and click 
the Add button” section: 
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Figure 4.19: Extracting NSF file for migration 

7. Select the Add Name for new GroupWise Mailbox check box if you want to specify a new name 
to the GroupWise mailbox. For example, if the current name of the NSF file is Database1 and you 
want to keep this name as GroupWise Database 1 then select the Allow user to select or add 
GroupWise Mailbox name check box and type the new name 

 If you have selected multiple NSF files, then specifying a new name will merge the 
email folders in the NSF files and a single GroupWise mailbox will be created at the 
specified location. If you do not want to merge folders of NSF files then you should 
not select the Allow user to select or add GroupWise Mailbox name check box. 

8. Click the Add button. The software displays a message that selected files are added for migration: 
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Figure 4.20: Selecting NSF files to Software main window 

9. Click the OK button. All selected NSF files are displayed in the software main screen: 
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Figure 4.21: Migration of NSF files fetched from Domino Server 

10. Select the file if you want to preview it before migrating into GroupWise mailbox.  

11. After selecting the file, click the Preview button. The software displays preview of the selected NSF 
file.  

12. Select a folder to preview its items. The software starts listing items of the selected folder.  

13. After previewing, click the Export button. The “Options for Migration” dialog box appears.  

14. Click the Browse button to specify a location to save the GroupWise mailbox. The “Browse for 
Folder” dialog box appears.  

15. Select a location and click the OK button. The selected location will be displayed in the “Options for 
Migration” dialog box.  

16. Click the Next button. The “Items to Migrate” page appears enabling you to select item types that 
you want to migrate.  
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17. Select objects that you want to migrate and unselect that you do not want to migrate into 
GroupWise mailbox.  

18. Click the Next button. The “Date Range to Migrate” page appears allowing you to specify a date 
range based on which the software will migrate item types to GroupWise.  

On this page, you are provided with two options – Predefined and User defined. Selecting the 
Predefined option will enable you to specify a date range from the available list of date range while 
the User defined option allows you to specify your own date range.  

19. Specify the date range and click the Next button. The “Quality and Speed of Migration” page 
appears allowing you to select a saving option.  

Based on the saving option that you will select, the speed of migration will vary. Mentioned below 
are the saving options that you can select for migrating NSF to GroupWise:  

 Save emails in text format - fastest speed: Saves data in textual format. It is the fastest 
mode of migration in Kernel for Lotus Notes to Novell GroupWise.  

 Save emails in rtf format - Low Quality - Medium Speed: Saves data in RTF format. 
Selecting this mode will slows down the speed of migration but the quality (formatting, 
properties, structure, etc.) of the emails, contacts, etc. will be better than the emails migrated 
using Save emails in text format – fastest speed option.  

 Save emails in rtf format - best Quality - Lowest Speed: Also saves data in RTF format 
but produces the best quality i.e. the data will be migrated in the same format as it was in 
NSF file. However, this option may take some large time in migrating NSF to GroupWise.  

20. Select an option and click the Next button. The software starts converting NSF to GroupWise.  

After the process gets completed, a message saying Migration Completed appears. Click the OK 
button to close the dialog box displaying the message.  
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5. Full Version of the Software  

Although you can use Kernel for Lotus Notes to Novell GroupWise evaluation version for free and 
experience the capabilities of the software, there are certain features that are not available in the 
evaluation version. 

5.1 Requirement of Full Version 

By using the evaluation version of Kernel for Lotus Notes to Novell GroupWise, you can easily migrate 
NSF file data to GroupWise mailbox; however, you cannot save and view the entire content of NSF files.   

Free demo simply migrates 10 emails per folder of the NSF file to Novell GroupWise mailbox. Therefore, 
in order to save the entire migrated data in the GroupWise mailbox, you need to purchase the product key 
of the software. 

 

5.2 Purchasing Full Version 

You can buy the full version of Kernel for Lotus Notes to Novell GroupWise from any one of our authorized 
resellers – Element5, Asknet and 2CO. 

As soon the purchase transaction with our resellers gets completed, our sales team will send you an email 
comprising the URL to download the full version of Kernel for Lotus Notes to Novell GroupWise and 
activation details of the software. 
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6. Support 

We have an extensive and efficient support system in place to assist our customers with all issues related 
to using Kernel for Lotus Notes to Novell GroupWise. The software comes with an embedded help manual 
that can be accessed by clicking HelpSoftware Help in the menu-bar. You can also press the F1 key on 
the keyboard of your computer to access the embedded help of Kernel for Lotus Notes to Novell 
GroupWise. 

You can access the online help for Kernel for Lotus Notes to Novell GroupWise at 

http://www.nucleustechnologies.com/Online-Helps.html 

We also have live support wherein you can chat with our software experts at 

http://www.nucleustechnologies.com/Support.html . 

To talk on phone with our software experts call: 

Help line:  
 

+91-9818725861 

1-866-348-7872 (Toll Free for USA/CANADA) 

You can also email us about your queries at; 

sales@nucleustechnologies.com for Sales 

support@nucleustechnologies.com for Support 

contact@nucleustechnologies.com for General Queries 

http://www.nucleustechnologies.com/Online-Helps.html
http://www.nucleustechnologies.com/Support.html
mailto:sales@nucleustechnologies.com
mailto:support@nucleustechnologies.com
mailto:contact@nucleustechnologies.com
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7. Troubleshooting 

This section deals with your generic and specific queries pertaining to using Kernel for Lotus Notes to 
Novell GroupWise. 

7.1 Common Issues 

Does the evaluation version of Kernel for Lotus Notes to Novell GroupWise have certain limitations? 

Although you can use Kernel for Lotus Notes to Novell GroupWise evaluation version for free and 
experience the capabilities of the software, there are certain features that are not available in the 
evaluation version. By using the evaluation version of Kernel for Lotus Notes to Novell GroupWise, you 
can convert and preview all the migrated data; however, you cannot save the entire migrated content of 
the NSF files.  

 

7.2 Frequently Asked Questions 

How to Buy Kernel for Lotus Notes to Novell GroupWise? 

You can buy Kernel for Lotus Notes to Novell GroupWise online at  
http://www.nucleustechnologies.com/buy-notestogroupwise.html . 

I have lost my full version for Kernel for Lotus Notes to Novell GroupWise. Can you help me? 

Please email us at sales@nucleustechnologies.com. Please include your name, address, email 
address, and order confirmation number (if you have it). We will be happy to help you. 

 

 

http://www.nucleustechnologies.com/Buy-Data-Recovery-Software.html%20.
http://www.nucleustechnologies.com/Buy-Data-Recovery-Software.html%20.
mailto:sales@nucleustechnologies.com
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8. Legal Notices 

This section comprises the legal specification about Kernel for Lotus Notes to Novell GroupWise and the 
company LEPIDE SOFTWARE PRIVATE LIMITED 

8.1 Copyright 

LEPIDE SOFTWARE PRIVATE LIMITED, Kernel accompanied user manual and documentation are 
copyright of LEPIDE SOFTWARE PRIVATE LIMITED, with all rights reserved. Under the copyright laws, 
this user manual cannot be reproduced in any form without the prior written permission of LEPIDE 
SOFTWARE PRIVATE LIMITED. No Patent Liability is assumed, however, with respect to the use of the 
information contained herein. 

© LEPIDE SOFTWARE PRIVATE LIMITED. All rights reserved. 

8.2 Trademark 

Kernel for Lotus Notes to Novell GroupWise ® is a copyright work of LEPIDE SOFTWARE PRIVATE 
LIMITED 

Windows 95®, Windows 98®, Windows ME®, Windows NT®, Windows 2000 Server®, Windows 2000 
Advanced Server®, Windows 2003 Server®, Windows XP®, Windows Vista are registered trademarks of 
Microsoft Corporation. 

All other brand and product names are trademarks or registered trademarks of their respective companies. 

8.3 Disclaimer 

The Information contained in this manual, including but not limited to any product specifications, is subject 
to change without notice. LEPIDE SOFTWARE PRIVATE LIMITED provides no warranty with regard to 
this manual or any other information contained herein and here by expressly disclaims any implied 
warranties of merchantability or fitness for any particular purpose with regard to any of the foregoing 
LEPIDE SOFTWARE PRIVATE LIMITED assumes no liability for any damages incurred directly or 
indirectly from any technical or typographical errors or omissions contained herein or for discrepancies 
between the product and the manual. In no event shall LEPIDE SOFTWARE PRIVATE LIMITED, be liable 
for any incidental, consequential special, or exemplary damages, whether based on tort, contract or 
otherwise, arising out of or in connection with this manual or any other information contained herein or the 
use there of. 

8.4 License Agreement 

Kernel for Lotus Notes to Novell GroupWise Copyright © by LEPIDE SOFTWARE PRIVATE LIMITED 

Your Agreement to this License 

You should carefully read the following terms and conditions before using, installing or distributing this 
software, unless you have a different license agreement signed by LEPIDE SOFTWARE PRIVATE 
LIMITED. The terms and conditions of this License describe the permitted use and users of each Licensed 
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Copy of Kernel for Lotus Notes to Novell GroupWise. For purposes of this License, if you have a valid 
license, you have the right to use a single Licensed Copy of Kernel. 

Scope of License 

Each Licensed Copy of Kernel for Lotus Notes to Novell GroupWise may either be used by a single 
person or used non-simultaneously by multiple people who use the software personally installed on a 
single workstation. All rights of any kind in Kernel, which are not expressly granted in this License, are 
entirely and exclusively reserved to and by LEPIDE SOFTWARE PRIVATE LIMITED. You may not rent, 
lease, modify, translate, reverse engineer, decompile, disassemble, or create derivative works based on, 
Kernel, nor permit anyone else to do so. You may not make access to Kernel available to others in 
connection with a service bureau, application service provider, or similar business, nor permit anyone else 
to do so. 

Warranty Disclaimers and Liability Limitations 

Kernel for Lotus Notes to Novell GroupWise, and any and all accompanying software, files, data and 
materials, are distributed and provided AS IS and with no warranties of any kind, whether expressed or 
implied. In particular, there is no warranty for the quality of data recovered. You acknowledge that good 
data processing procedure dictates that any program, including Kernel for Lotus Notes to Novell 
GroupWise, must be thoroughly tested with non-critical data before there is any reliance on it, and you 
hereby assume the entire risk of all use of the copies of Kernel for Lotus Notes to Novell GroupWise 
covered by this License. This disclaimer of warranty constitutes an essential part of this License. In 
addition, in no event does LEPIDE SOFTWARE PRIVATE LIMITED authorize you or anyone else to use 
Kernel for Lotus Notes to Novell GroupWise in applications or systems where Kernel for Lotus Notes to 
Novell GroupWise failure to perform can reasonably be expected to result in a significant physical injury, 
or in loss of life. Any such use is entirely at your own risk, and you agree to hold LEPIDE SOFTWARE 
PRIVATE LIMITED harmless from any and all claims or losses relating to such unauthorized use.  

General 

This License is the complete statement of the agreement between the parties on the subject matter, and 
merges and supersedes all other or prior understandings, purchase orders, agreements and 
arrangements. This License shall be governed by the laws of the State of Delhi. Exclusive jurisdiction and 
venue for all matters relating to this License shall be in courts and for a located in the State of Delhi, and 
you consent to such jurisdiction and venue. There are no third party beneficiaries of any promises, 
obligations or representations made by LEPIDE SOFTWARE PRIVATE LIMITED herein. 

Any waiver by LEPIDE SOFTWARE PRIVATE LIMITED of any violation of this License by you shall not 
constitute, nor contribute to, a waiver by LEPIDE SOFTWARE PRIVATE LIMITED of any other or future 
violation of the same provision, or any other provision, of this License. 


